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1  BlockSim 7 Training Guide

1.1  About this Training Guide
This training guide is intended to provide you with many examples of BlockSim. It begins with step-
by-step examples and then proceeds into more advanced examples and questions. At any time during
the training, please feel free to ask the instructor(s) any questions you might have.

Unless otherwise noted, these examples and results are created using the default settings that are
shipped with the software. Altering these settings can affect the software’s appearance and/or the
results given.

1.2  BlockSim Documentation
Like all of ReliaSoft's standard software products, BlockSim is shipped with detailed printed
documentation on the product (BlockSim 7 User's Guide) and on the underlying principles and theory
(ReliaSoft's System Analysis Reference: Reliability, Availability and Optimization). This training
guide is intended to be a supplement to those references.



1.3  Contacting ReliaSoft
ReliaSoft can be reached at:

ReliaSoft Corporation
Worldwide Headquarters

1450 S. Eastside Loop
Tucson, AZ 85710   USA
Phone: +1.520.886.0366

Fax: +1.520.886.0399
E-mail: Support@ReliaSoft.com

For up-to-date product information, visit our Web site at: 
http://BlockSim.ReliaSoft.com 



2  Features Summary

BlockSim 7 allows you to perform complex system reliability, maintainability and availability
analysis and optimization using a reliability block diagram (RBD) approach, a fault tree diagram
(FTD) approach or a combination of both. 

The examples in this training guide have been designed to introduce you to the features available in
BlockSim 7. This section presents a brief summary of these features. If you are already familiar with
BlockSim’s features, you can proceed to Chapter 3, First Steps.

2.1  Using BlockSim 7
BlockSim 7 allows you to analyze any process or product to obtain exact system reliability results
(including system reliabilities, mean times, failure rates, etc.), to calculate the optimum scenario to
meet system reliability goals and to obtain maintainability, availability and throughput results through
discrete event simulation. BlockSim's blocks can be defined with the reliability characteristics of each
component of the process or product. You can then configure these blocks into a reliability block
diagram (RBD) that represents the reliability-wise configuration of the system and analyze the
diagram in order to determine the reliability function (cumulative density function or cdf) of the entire
system. This analysis can be used to make statistical calculations and create plots, to perform “what-
if” analyses and to determine the optimization of system reliability to meet time and cost goals that
you specify. When you define each block’s maintenance characteristics, you can also perform
maintainability/availability and throughput simulations.
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2.2  What’s new in Version 7?
BlockSim 7 provides more realistic simulations and better reporting. Specific additions and enhancements
include:

• Additional Distributions for both analytical and simulation analyses. You can now select from
Weibull, mixed Weibull (with two, three and four subpopulations), normal, lognormal, exponential,
generalized gamma, gamma, logistic, loglogistic and Gumbel distributions.

• Phase Diagrams offer a new capability to model systems that change during the course of a simulation.
For example, some airplane components only operate during the take-off and landing phases of a
mission, but not during the cruising phase. Likewise, a manufacturing company’s production may
change during different shifts. Phase Diagrams capture changes in system usage and reliability during
different time periods, resulting in more accurate simulations.

• Duty Cycle allows you to apply a stress factor to one or more components or phases of a system,
quickly and easily manipulating the failure distribution parameters of a diagram. For example, a system
component that does not work continuously (e.g. a CD-ROM drive in a computer) would accumulate
less usage than the system accumulates. The Duty Cycle allows you to specify such usage as a property
of the individual block or phase, creating a more realistic model of the system.

• Variable Throughput allows you to specify time-dependent throughput changes. For example, the
flow of oil from a well may drop over time as the oil reserves are depleted. BlockSim 7 offers three
different models to describe a system’s variable throughput.

• Type I Restoration Factor allows you to model imperfect maintenance scenarios and define
maintenance that reduces a specified portion of damage since the last repair. BlockSim 7 also supports
the Kijima Type II model, where the maintenance is assumed to reduce a specified portion of the total
damage to the item.

• Resource Usage Window provides an at-a-glance view of the diagrams and blocks where resources are
used in a project, in either a list or dependency tree view. You can also use this utility to delete all
unused resources in a single batch.

• FRED Reports have been expanded to include Analytical FRED Reports, which provide graphical
representations of a non-repairable system’s reliability characteristics to help identify components that
may require improvement.

2.3  Fault Tree Analysis
Fault tree diagrams are used for performing fault tree analysis (FTA), which is one of many symbolic
analytical logic techniques found in operations research and in system reliability. BlockSim 7 allows you to
perform system reliability analysis using fault tree diagrams or reliability block diagrams or combinations of
both within the same project.  

2.4  Intuitive Work Environment
BlockSim's interface is an intelligent, flexible and completely integrated work center in one comprehensive,
easy-to-use package. The work environment is designed around the Multiple Document Interface (MDI) and
BlockSim's Project Explorer. These tools allow you to display and manage the Diagram Sheets, Fault Tree
Sheets, Phase Diagram Sheets, Maintenance Templates, Spreadsheets, Plot Sheets, Templates, Resources
and Attachments you will create and use in BlockSim. From within BlockSim's MDI, you can use
BlockSim's integrated calculation and plotting tools to analyze your diagrams, make system reliability
calculations, create and modify plots and graphics and calculate the optimum reliability scenario. You can
also easily interact with other ReliaSoft and Windows applications. 
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2.5  Powerful and Easy to Use
ReliaSoft's BlockSim was designed and built for Microsoft Windows and takes full advantage of the best
features Windows has to offer. Using the familiar Windows interface, as well as the examples and help
provided, you can be up and running from the moment the application is installed. You can be productive
immediately, without the normal downtime you would expect when learning a new software application. But
making BlockSim easy does not mean we made it less powerful. BlockSim comes packed with advanced
features that you will find indispensable and you will learn and master them as you explore the software.
Complete on-line help is also provided.

2.6  Blocks and Templates
BlockSim's blocks are the building blocks with which you will create complex reliability block diagrams
and fault tree diagrams. You can start with BlockSim's Templates, which contain pre-defined sets of re-
usable blocks. BlockSim provides a gallery of Templates to get you started and provides you with the
flexibility to manage these collections of building blocks to meet your specific needs. You can customize
individual blocks with the failure, maintenance, reliability optimization, throughput and other characteristics
for each component in your system. 

2.7  Available Life Distributions
The life distributions available within BlockSim that define the failure, maintenance and other time-
dependent characteristics of system components include the Weibull, mixed Weibull (with two, three or four
subpopulations), normal, lognormal, exponential, generalized gamma, gamma, logistic, loglogistic and
Gumbel distributions. BlockSim also provides the capability to compute the appropriate distribution and
parameters for a component using ReliaSoft's Weibull++ life data analysis software and ReliaSoft’s ALTA
accelerated life testing analysis software.

2.7.1  Integration with Weibull++ and ALTA
The capabilities of ReliaSoft's suite of reliability engineering software products have been designed to
complement one another. With BlockSim 7, you can use a new or existing file created in ReliaSoft's
Weibull++ or ALTA software to define the failure or maintenance characteristics of a BlockSim block.1
Contact ReliaSoft for information on obtaining these powerful life data analysis applications.

2.8  System Reliability Block Diagrams and Fault Tree Diagrams
Simple drag-and-drop functionality allows you to drag blocks from a Template into a Diagram Sheet or
Fault Tree Sheet and configure those blocks to create simple or complex reliability block diagrams (RBDs)
or fault tree diagrams. With BlockSim, you can diagram systems with series, parallel and “k-out-of-n”
reliability-wise configurations, as well as complex combinations of those configuration types. You can also
create standby and load sharing redundancy configurations.

In BlockSim 7 you can also create AND gate, OR gate, voting OR gate, complex gate, load sharing gate and
inhibit gate configurations.

BlockSim also allows you to customize the size and shape of component blocks, connecting lines, diagram
background, graphics and text.

1. Weibull++ version 6.0.11 or later and/or ALTA version 6.0.10 or later must be installed on your computer in order to 
use this option. For more powerful analyses and even greater integration, upgrade both Weibull and ALTA to version 7.
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2.8.1  Template Blocks
Template blocks are the main building blocks of your reliability block diagrams and fault tree diagrams. You
can define these re-usable blocks with the failure, maintenance, reliability, optimization and throughput
characteristics of the components they represent. BlockSim's Template blocks allow you to define the
characteristics of a component once and use the same block in many diagrams to save time. 

2.8.2  Node Blocks
Node blocks are another type of block that can be used in the reliability block diagrams you create. Node
blocks act as switches through which RBD paths move. You can specify how many paths leading into a node
must be operational in order for the node to function. You can also define the properties of the node itself,
including whether it can fail and its failure distribution. 

2.8.3  Subdiagram Blocks
In addition to the complex reliability-wise configurations supported by BlockSim's Diagram Sheets and
Fault Tree Sheets, you can also link diagrams by using existing RBDs or FTDs as components in other
diagrams. BlockSim's Block As Diagram option creates a block that represents the reliability characteristics
of an existing BlockSim diagram. This block serves as a subdiagram to the current diagram. This
subdiagram block can then be placed into any diagram as a component. 

2.8.4  Container and Contained Blocks
Container blocks allow you to identify blocks that operate in a standby or load sharing configuration. The
container block has properties that describe the way the container behaves and the configuration of the
blocks within the container.

Contained blocks are blocks that exist inside container blocks. Contained blocks describe the characteristics
of the items that operate together in the standby or load sharing configuration.

2.8.5  Multi Blocks and Mirrored Blocks
Multi blocks allow you to create a single block that represents more than one component with the same
properties. This allows you to save time and space when creating your RBDs. In addition, mirrored blocks
allow you to place the exact same component in more than one location, represented by multiple blocks,
within the RBD or FTD. This can be useful to simulate bi-directional paths within the diagram.

2.9  Policies
BlockSim allows you to define policies, which are sets of rules that describe various aspects of the
maintenance approach for particular blocks. A unique policy is required for each aspect of the maintenance
approach (e.g. corrective maintenance, work crews, etc.) and for each block or set of blocks that follows a
different set of rules to govern maintenance activities.

BlockSim allows you to define the following types of policies:

• Corrective Maintenance Policies, which describe the conditions that determine when corrective
maintenance will be performed on an item.

• Preventive Maintenance Policies, which describe the conditions that determine when preventive
maintenance will be performed on an item.

• Inspection Policies, which describe the conditions that determine when an inspection will be performed
on an item.
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• Crew Policies, which describe the conditions that determine when a crew will be available to perform
specific actions and specifies the logistical time and costs associated with engaging the crew.

• Spare Parts Pools, which describe the conditions that determine whether a spare part will be available
when needed and specifies the logistical time and costs associated with obtaining the spare part.

• Feasibility Policies, which allow you to define a cost function for the difficulty or cost of increasing the
reliability of a block.

2.10  Analytical Quick Calculation Pad
ReliaSoft's Analytical Quick Calculation Pad (QCP) provides a quick, easy and accurate way for you to
obtain exact results for the most frequently asked reliability questions. Everything from standard probability
and mean time calculations, to optimization algorithms is possible using the Analytical QCP. All QCP
results can be displayed and manipulated in the Results Panel and BlockSim’s flexible Spreadsheets. 

2.10.1  Reliability Metrics
BlockSim's powerful analysis engines analyze the diagrams you create in order to obtain the complete
mathematical system reliability function (or cumulative density function, cdf). You can use that actual
system cdf to obtain exact reliability results from the Analytical QCP. Calculations include reliability,
probability of failure, conditional reliability, conditional probability of failure, failure rate, warranty time,
B(X) information and mean time.

2.10.2  “What-If” Analyses
In addition to providing quick, easy reliability calculations for the system diagrams you create, BlockSim
provides you with the flexibility to manipulate a diagram in order to perform “what-if” analyses. BlockSim
allows you to mark a component (or components) as inactive (i.e. failed, off or absent from the system) and
use the Analytical QCP to determine reliability metrics of the system under those hypothetical conditions.

2.10.3  Optimize System Reliability
You can also use BlockSim's Analytical QCP to calculate the best way to optimize system reliability based
on time and cost goals that you provide. You can specify system reliability and time goals and select
components to be considered when calculating the optimum scenario for meeting those goals. Based on your
specification of the feasibility (or cost) of improving the reliability of each individual component, BlockSim
calculates the optimum scenario for increasing component reliability in order to achieve a system reliability
goal. You can use BlockSim’s feasibility functions or specify your own customized functions to describe the
cost feasibility for increasing the reliability of a specific component.

2.11  Maintainability/Availability Simulations
BlockSim’s Maintainability/Availability Simulation window allows you to estimate system maintainability,
availability and throughput results via simulation. BlockSim’s simulations are based on the component
characteristics and the reliability-wise system configuration of the linked Diagram Sheet or Fault Tree Sheet.

2.11.1  Simulation Results Explorer
The results generated from BlockSim’s Maintainability/Availability Simulation window can be displayed in
the Simulation Results Explorer. From the Simulation Results Explorer, you can edit, cut, copy, paste, print
and/or transfer the results to a Spreadsheet or to Excel. You can also send the data to Weibull++, ReliaSoft’s
life data analysis software, if the software is installed on your computer, for further analysis.
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2.11.2  Simulation Quick Calculation Pad
BlockSim’s Simulation QCP allows you to perform calculations based on the simulation results. These
calculation results include availability, unavailability, reliability, probability of failure, mean availability,
mean unavailability, availability time, reliability time and MTTF.

2.12  Sequence Animation
The Sequence Animation utility allows you to animate the sequence of a single iteration of the simulation
for the current reliability block diagram or fault tree diagram. You can then save the animation as an Audio
Video Interleave (*.avi) file, which can be inserted into a PowerPoint presentation or used for other video
presentation purposes.

2.13  Unparalleled Plots and Graphs
BlockSim offers unparalleled plotting and graphing capabilities. With the click of a button, you can create
Unreliability vs. Time, Reliability vs. Time, pdf, Failure Rate vs. Time, Reliability Importance vs. Time,
Static Reliability Importance and Tableau Reliability Importance plots based on system RBDs or FTDs, as
well as plots based on individual block reliabilities.

You also can create plots based on the simulation results. The simulation plot types include ReliaSoft Failure
Criticality Index, ReliaSoft Failure Criticality Index Tableau, ReliaSoft Downing Event Criticality Index,
ReliaSoft Downing Event Criticality Index Tableau, Point Availability, Point Reliability, Both Point
Availability and Reliability, System Up/Down and Block Up/Down plots. BlockSim also allows you to
create simulation plots based on the blocks, maintenance crews or spare part pools in the current Diagram
Sheet or Fault Tree Sheet.

BlockSim also gives you the flexibility to create a variety of plots and graphs with the Chart Wizard in
BlockSim's Spreadsheets. With the Chart Designer, any of these graphs can be extensively customized to
meet your particular needs. All BlockSim plots can be saved as Windows metafile (*.wmf) graphics that can
be used in other applications. 

2.14  Spreadsheets
With BlockSim's Spreadsheets, you can unleash endless possibilities. These Spreadsheets can be used just as
you would use an Excel spreadsheet with complete in-cell formula support, cell references and over 140
built-in functions. Use this flexibility, coupled with all of the powerful data analysis capabilities of
BlockSim, to perform calculations, create plots and graphs and prepare presentations of your analyses. 

2.15  Function Wizard
You can use ReliaSoft's Function Wizard in conjunction with BlockSim's Spreadsheets to generate a variety
of calculated results. The Function Wizard returns results based on a linked RBD or FTD. These results
include tables of failure rates given a time range, mean times of the system, reliability given time and more.
You can also use the Chart Wizard and BlockSim’s Spreadsheets to create custom graphs and reports to
present your analyses. 

2.16  Customize the Application
BlockSim provides a User Setup that allows you to customize the application to meet your particular needs.
The User Setup allows you to configure the software to suit the way you and your company work. You can
customize the way the software works and looks, or use the preferences pre-set by ReliaSoft. For example,
you can determine the decimal place accuracy you would like to see, for up to fifteen decimal places, and set
the displayed math precision to be used for the axis numbers on the plots. 



Features Summary BlockSim 7

                                          http://BlockSim.ReliaSoft.com   9

2.17  A Note on BlockSim Calculations
The results generated by BlockSim's analysis tools do not specify the units (e.g. hours, miles, etc.) for the
values returned. It must be understood that the units for the results are the same as the units for the data
inputs on which results are based. For this reason, BlockSim requires a uniformity of units among the
property definitions of blocks in Diagram Sheets and Fault Tree Sheets and required inputs for calculations.
For example, all time values in a Diagram Sheet or Fault Tree Sheet and in the analysis tools used to
generate results based on that diagram must be defined with the same units.





3  First Steps

3.1  Starting BlockSim 7
BlockSim is a 32-bit application that has been designed to work with Windows NT, Windows 2000
and Windows XP.1 To start BlockSim, from Start select Programs, ReliaSoft Office, BlockSim 7.
The figures used in this manual, as well as the commands required, are all from Windows XP.
However, the BlockSim internal screens and commands are identical regardless of which operating
system you are using and this manual is equally applicable.

3.2  Multiple Document Interface 
The Multiple Document Interface (MDI) is the main window and “manager” for BlockSim. The MDI
serves as the container for all the windows you will use in BlockSim. 

The menu and toolbar options available within BlockSim's MDI will vary depending on the windows
that are currently open. In addition, BlockSim's flexible MDI allows the user to configure the
workspace to meet individual needs by hiding or moving the menu bar, toolbars, Project Explorer and
Template Panel. 

1. For information about compatibility with Windows Vista, see ReliaSoft’s online Technical Support
Knowledge Base, Document # RS20013.
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The next figure displays the MDI and its components so that you can familiarize yourself with the options
available within the MDI. Your screen may look slightly different from the one shown next, depending on
the windows and tools currently open and on the configuration settings that you have established. 

3.3  Getting Help in the BlockSim Environment
ReliaSoft's BlockSim 7 includes complete on-line help documentation. This help can be obtained at any time
by pressing F1 or by selecting Contents from the Help menu. 

3.4  BlockSim: A Familiarization

3.4.1  A Quick Overview Example
This section presents you with a very simple example and guides you through the solution. A simple system
consists of three resistors configured reliability-wise in series. The failure characteristics of each component
are presented in the table shown next. Create a reliability block diagram (RBD) to represent the system, plot
the Unreliability vs. Time of the system and calculate the reliability of the system at 50 days of operation.

Component Failure Distribution Parameters

Resistor 1 Exponential Mean Time = 1,000
Gamma = 0

Resistor 2 Exponential Mean Time = 500
Gamma = 0

Resistor 3 Exponential Mean Time = 333.33
Gamma = 0
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3.4.2  Create a New BlockSim Project
• The first step is to create a new project by selecting New from the File menu or by clicking the New

icon. 

• The New Project Wizard will appear like the one shown next. The Wizard will guide you through the
process of creating a new project by asking you a series of questions pertaining to the type of project
you want to create.

• The first page of the New Project Wizard allows you to specify whether you will create a new project
based on a base project or incorporate items, such as Diagram Sheets, Fault Tree Sheets, Spreadsheets,
MultiPlot Sheets, Templates, Resources and Attachments, from an existing project. For this example,
you will create a new, blank project. Select the Blank project option and click Next>.

• The second page of the Project Wizard will appear, which allows you to make selections to determine
which items (Diagram Sheets, Fault Tree Sheets, Templates, etc.) will be automatically placed into the
new project. The appearance of this page will vary depending on your selection in Step 1. For this
example, select A new blank Diagram Sheet and A new blank Template and click Next>.

• The third page of the New Project Wizard will appear, which allows you to create a new project. Click
Finish.2

2. If the Rename window appears and asks you to enter a name for the new Diagram Sheet in your project, click OK to
accept the default name.
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• The new project will appear, as shown next.

The Project Explorer will appear on the left side of the MDI. You can use the Project Explorer to manage the
items within your project. Items include Diagram Sheets, Fault Tree Sheets, Phase Diagram Sheets,
Maintenance Templates, Templates, Resources, MultiPlot Sheets, Reports, Spreadsheets and any
Attachments. From within the Project Explorer, you can add, import, export, rename and delete items within
the current project.

The appearance of the Project Explorer will vary depending on the docking option that is selected from the
Dock Project Explorer submenu, found in either the Project Explorer shortcut menu or the View menu.3 

If No Docking is selected, the Project Explorer will be displayed as a window. If Dock Left, Dock Right,
Dock Top or Dock Bottom is selected, the Project Explorer will be displayed as a fixed panel on the
corresponding side of the MDI. By default, the Project Explorer will be docked to the left side of the MDI,
as shown in the previous picture.

The Template Panel will appear at the bottom of the MDI. BlockSim’s Templates allow you to store re-
usable blocks, which can save you time and effort when building diagrams. Within projects, you can create
your own Templates in the Template Panel and then create blocks with pre-defined parameters and other
pre-set options in these Templates. You can then drag the Template blocks into a Diagram Sheet or Fault
Tree Sheet to build your diagram. The Template Panel always presents all of the Templates and the blocks
they contain associated with the current project. Each Template is accessible by clicking its page index tab.

3. Right-click inside the Project Explorer to display the Project Explorer shortcut menu, which provides you with the
commands that pertain to BlockSim projects.
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The appearance of the Template Panel will vary depending on the docking option that is selected from the
Dock Template Panel submenu, found in either the View menu or the Template Panel shortcut menu.4

If No Docking is selected, the Template Panel will be displayed as a window that can be moved freely
within the MDI. If Dock Left, Dock Right, Dock Top or Dock Bottom is selected, the Template Panel will
be displayed in a fixed Template Panel on the corresponding side of the MDI. By default, the Template Panel
will be docked at the bottom of the MDI, as shown in the previous picture.

The name of the new Template, Template1, appears on its corresponding page index tab.

A new Diagram Sheet will also appear in the MDI. BlockSim’s Diagram Sheets provide the canvas on which
you will create your reliability block diagrams (RBDs). The Control Panel that appears on the right side of
the Diagram Sheet allows you to perform analyses on the RBDs in the Diagram Sheet and displays the status
of the analytical analysis and simulation, as well as the number of blocks that exist in the Diagram Sheet. It
also displays information for the current Diagram Sheet or for the selected block in the Diagram Sheet, as
shown next.

4. Right-click inside the Template Panel to display the Template Panel shortcut menu, which provides you with the
commands that pertain to BlockSim Templates.
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3.4.3  Creating a Template Block
BlockSim blocks, defined with the reliability characteristics of system components, are the building blocks
you will use to create your diagrams. The next step is to create a new Template block that will be used as the
pattern for the Resistor blocks you will use in the diagram.

• To add a block to Template1, click the Template Panel or double-click the Template name in the Project
Explorer to activate it. Next, select Add Block from the Template menu or click the Add New Block
icon in the Diagram Tools toolbar.

• A block will appear in the Template and will be named “Block 1” by default, as shown next.

• To edit the properties of the new block, double-click it or select the block and then select Edit Block
Properties from the Block menu or from the Template Block shortcut menu.
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The Block Properties window will appear, as shown next, which allows you to define the new block with the
characteristics of the component.

• On the first page in the Block Properties window, the Item page, you can define the block name. Type
Resistor 1 in the Name input box.

• Next, you will define the failure characteristics of the Resistor 1 component. To do this, click the
Reliability tab and on the Failure Distribution page, verify that the Block Can Fail option is selected.
In addition, verify that the Static Reliability option at the bottom of the window is not selected. 5

• Click the green drop-down menu bar to select Exponential as the failure distribution and notice that the
parameter input boxes beneath to represent the parameter requirements of the selected distribution.
Type 1000 for the value of mean time and 0 for the value of gamma.6 

5. If the Block Can Fail option is not selected, the reliability of the block at all times is considered to be 1 or 100% and
the other options on the Failure Distribution page will be unavailable. The Static Reliability option is not selected,
indicating that a time-dependent failure distribution will be defined for the component. If the Static Reliability option is
selected, an input box will appear in which you can type the reliability of the component at a fixed point in time and the
other options on the Failure Distribution page will be unavailable.
6. By default in BlockSim, the exponential parameter is defined as mean time. Although the mean time definition is
appropriate for this example, you can also define the exponential parameter as lambda by de-selecting the Use Mean
Time for the Exponential distribution option on the Calculations page of the User Setup.
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• The Block Properties window will look like the one shown next. Note that the name change will not
take effect until you click OK to save the changes. 

• Click OK to close the Block Properties window and update the Template block’s properties. 

• The Template block will reflect your name change, as shown next.

• Repeat these steps to create two more Template blocks to represent the Resistor 2 and Resistor 3
components. On the appropriate pages of the Block Properties window for the Resistor 2 block, make
the following selections/entries:

General Tab: Item Page

Block Name: Resistor 2
Reliability Tab: Failure Distribution Page

Block Can Fail: Selected 
Failure Distribution: Exponential
Mean Time: 500
Gamma: 0
Static Reliability: Not Selected
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• On the appropriate pages of the Block Properties window for the Resistor 3 block, make the following
selections/entries:

General Tab: Item Page

Block Name: Resistor 3
Reliability Tab: Failure Distribution Page

Block Can Fail: Selected 
Failure Distribution: Exponential
Mean Time: 333.33
Gamma: 0
Static Reliability: Not Selected

3.4.4  Build a Simple Diagram
Now you are ready to build a simple reliability block diagram (RBD) by placing the Template blocks you
have created in the Template into the Diagram Sheet. You will do this by dragging the blocks from the
Template Panel into the Diagram Sheet.7

• First, drag the Resistor 1 block into the Diagram Sheet. To do this, click the block in the Template Panel
to select it, hold down the left mouse button, drag the cursor into the desired position on the Diagram
Sheet and release the mouse button. Your screen will look like the one shown next.

7. Please note that this example is meant to demonstrate the use of the Template Panel and Template blocks. However,
you can omit the step of adding blocks to the Template Panel and dragging them to the Diagram Sheet, as demonstrated
in this example, by adding them directly to the Diagram Sheet.
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Notice that a copy of the block is placed in the Diagram Sheet and the Template block remains in the
Template Panel. Template blocks are like re-usable patterns that you can use to save time and effort. When
you drag a Template block into a Diagram Sheet or Fault Tree Sheet, a separate block is created in the
Diagram Sheet or Fault Tree Sheet. The new block in the Diagram Sheet or Fault Tree Sheet is independent
of the block in the Template and you can modify it to meet the needs of the particular diagram.

• Next, drag the Resistor 2 and Resistor 3 blocks into the Diagram Sheet.

3.4.5  Arrange and Connect the Blocks
You are now ready to arrange and connect the blocks in the Diagram Sheet to create a reliability block
diagram (RBD) that will represent the reliability-wise configuration of the system.

• Place the blocks in a horizontal row with Resistor 1 on the left, Resistor 2 in the middle and Resistor 3
on the right. Drag the blocks as before by clicking the block to select it, holding down the left mouse
button, moving the cursor into the desired position and releasing the mouse button. Your Diagram Sheet
will look like the one shown next.

• Now you are ready to connect the blocks to represent the relationships between the components of the
system. Select Join Blocks from the Diagram menu or click the Join Blocks icon.

• When you move the cursor over the Resistor 1 block, the cursor will turn into a cross hair. This is the
tool that you will use to draw the relationship lines between the blocks. Hold down the left mouse
button and drag a line from the Resistor 1 block to the Resistor 2 block with which it will be connected.
When the cross hair is located above the second block, release the mouse button. A relationship line will
now connect the two blocks.8

• Next, connect the Resistor 2 block with the Resistor 3 block. When you have finished adding
relationship lines, you must right-click or double-click the Diagram Sheet or click the Join Blocks icon
again to stop adding relationships and return to BlockSim's normal mode.9

8. To delete a relationship line, click on the relationship line so that it turns red. Delete the relationship line by using the
delete key, or by right-clicking for the shortcut menu and selecting Delete, or by selecting Delete from the Edit menu.
9. If you do not right-click the Diagram Sheet or click the Join Blocks icon to return the cursor to its normal mode, you
may not be able to perform other activities in BlockSim. If you are experiencing difficulties with the program, make sure
that the cursor is in its normal mode.
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• Your diagram will now look like the one shown next. Notice that the connecting line arrows point from
the source blocks to the destination blocks to represent the flow of the system. The specification of
source and destination blocks is relevant to BlockSim's analysis of the system configuration. 

3.4.6  Analyze the Diagram
Now that you have defined the reliability characteristics of each component block and arranged and
connected the blocks to represent the system, you are ready to analyze the diagram. 

• Select Analyze from the Tools menu or click the Analyze icon.

• Notice that the Analytical status button on the Diagram Sheet Control Panel has turned from red to
green, indicating that the Diagram Sheet has been analyzed.

• You can then view the equation used for the analysis in the System Reliability Equation window by
selecting Show Algebraic Solution from the Tools menu or by clicking the Show Algebraic Solution
icon on the Diagram Sheet Control Panel. 

• The exact analytical equation for the system will appear in the window, as shown next.

• Click Close to close the System Reliability Equation window and return to the Diagram Sheet.
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3.4.7  Plot Unreliability vs. Time
• Now you can generate plots based on the system analysis. Select Analytical Plot from the Tools menu

or click the Analytical Plot icon.

• The Unreliability vs. Time plot will appear in the Analytical Plot Sheet that is added to the Diagram
Sheet, as shown next. If you have already created a plot in BlockSim, the plot type of the last plot that
you created will appear. If a plot other than the Unreliability vs. Time plot appears, select Unreliability
vs. Time from the Plot Type drop-down menu.

Additional plots are also available in BlockSim's Analytical Plot Sheet, including Reliability vs. Time, pdf,
Failure Rate vs. Time, Reliability Importance vs. Time, Static Reliability Importance, Tableau Reliability
Importance and several block plots. Select a plot type from the Plot Type drop-down menu, as shown next. If
Auto Refresh is selected on the Control Panel, the Analytical Plot Sheet will be automatically updated to
display the plot type you have selected.

• Now return the focus to the Diagram Sheet by clicking its page index tab at the bottom of the window.

3.4.8  Calculate System Reliability
In addition to generating system reliability plots, BlockSim is also capable of calculating standard system
reliability metrics based on the exact system reliability function.

• To calculate the reliability of the system at a specified time, select Analytical QCP from the Tools
menu or click the Analytical QCP icon.
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• The Analytical Quick Calculation Pad (QCP) will appear. You can use the first page of the QCP, the
General page, to obtain standard reliability calculations. To determine the reliability of the system at 50
days, select Std. Probability Calculations under System Calculations. Type a Mission End Time of 50
under Required Input From User. Finally, click Calculate and the estimated system reliability at the
given time will appear under Results, as shown next.

• You can see that the reliability of the system at 50 days is 0.7408 or about 74.08%. Click Close to close
the Analytical Quick Calculation Pad and return to the Diagram Sheet.
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3.4.9  Save and Close the Project
• Now save the project. To do this, select Save from the File menu or click the Save icon.

• The Save As window will appear. Select to save the file in the BlockSim7/Examples/Training Guide
folder and type 1stStep as the file name. Accept the default file type, ReliaSoft BlockSim 7 files (*.rbp),
as shown next.

• Click Save to save the file. If you are working with an evaluation copy of BlockSim, you will not be
able to save the project. In this case, simply close the project and proceed with the rest of the examples
in the training guide. 

• After saving the file, close the project by selecting Close from the File menu. You will now be looking
at the MDI without any projects open.



4  Step-by-Step Examples

This chapter provides the following step-by-step examples, which are designed to introduce you to
the features of the BlockSim software:

• Example 1: Optimized Reliability Allocation I - page 26

• Example 2: Optimized Reliability Allocation II - page 35

• Example 3: Working with Subsystems - page 40

• Example 4: Integration with Weibull++ and Using Spreadsheets in BlockSim - page 43

• Example 5: Estimating Reliability, Downtime and Maintenance Costs - page 54

• Example 6: Fault Tree Analysis - page 65

• Example 7: Phase Diagrams I - page 70

• Example 8: Phase Diagrams II - page 78
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4.1  Example 1: Optimized Reliability Allocation I
A computer consists of two Hard Drives and a Circuit Board. The two Hard Drives operate reliability-wise
in parallel within the system. The reliability and optimization characteristics of each component are
presented in the table shown next.

Do the following:

• Create a reliability block diagram (RBD) of the system.

• Calculate the reliability of the system at 730 days (2 years) of operation.

• Calculate the reliability of the system at 730 days if the Hard Drive 1 component is removed from the
system.

• Determine the optimum scenario for increasing the reliability of each component in order to achieve a
system reliability of 0.98 (or 98%) at 730 days of operation.

Solution

• Create a new project by selecting New from the File menu or by clicking the New icon.

• The New Project Wizard will appear. For this example, you will create a new project using an existing
base project. A base project contains pre-defined Templates and Resources, such as maintenance, crew
and spare pool policies, that will be placed automatically into the new project.

• In Step 1 of the New Project Wizard, select to create a new project using an existing base project and
click Next>.

• In Step 2 of the New Project Wizard, click the Open icon.

• In the window that appears, browse through the “BlockSim7\Examples\Training Guide” folder to locate
the Example1.rbb base project. Once you have selected the base project, click Open.

• Select the Example1 base project and select to include a new blank diagram. Click Next>.

• In the last step of the New Project Wizard, click Finish.

Component Failure 
Distribution Parameters Max Achievable 

Reliability
Feasibility of Increasing 

Reliability

Hard Drive 1 Weibull
Beta = 2.5

Eta = 3,000 days
Gamma = 0

.999 Moderate

Hard Drive 2 Exponential
Mean Time = 

10,000
Gamma = 0

.999 Easy

Circuit Board Weibull
Beta = 1.5

Eta = 5,000 days
Gamma = 0

.999 Hard
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• The Project Explorer, Template Panel and a blank Diagram Sheet will appear. Your screen will look like
the one shown next.

• As mentioned in the First Steps example, the Diagram Sheet is the workspace in which you will create
simple or complex diagrams that represent the reliability characteristics of systems or processes. The
Project Explorer appears on the left side of the MDI and the Template from the base project, Example1,
appears in the Template Panel at the bottom of the MDI. 

• You are now ready to build a simple reliability block diagram (RBD) by dragging blocks from the
Example1 Template into the Diagram Sheet.

• Drag the Starting block from the Template into the Diagram Sheet. To do this, click the block in the
Template Panel to select it, hold down the left mouse button, drag the cursor into the desired position on
the Diagram Sheet and release the mouse button. The Starting block will represent the starting point of
the computer system in this example.

• Now drag the Hard Drive and Circuit Board blocks from the Template Panel into the Diagram Sheet.
Drag a second Hard Drive block into the diagram to represent the second Hard Drive component in the
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system. The Diagram Sheet will now contain four blocks and the Example1 Template will be
unchanged, as shown next.

The system in this example contains only three components: two Hard Drives and a Circuit Board. The Hard
Drives are connected in parallel. Therefore, the original system would look like the figure shown next.

However, a BlockSim diagram must have exactly one starting point and one ending point. Therefore, a
single starting point that does not possess failure characteristics (represented by the Starting block) was
introduced to close the system without impacting reliability calculations.

• To set the properties for the Starting Block, double-click the Starting Block in the Diagram Sheet to
open the Block Properties window. 

Hard Drive 1

Circuit Board

Hard Drive 2
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• Click the Reliability tab to view the Failure Distribution page, as shown next.

• On the Failure Distribution page, you can define the reliability characteristics of the component.
Because this block does not represent a component of the system with failure characteristics to be taken
into account, the Block Can Fail option must be de-selected to indicate that the component cannot fail.
Because the component cannot fail, the other options on the Failure page are unavailable.

• Now, select the first Hard Drive block that appears in the Active Block drop-down menu at the bottom
of the window to define the characteristics for the Hard Drive 1 block. If you made any changes to the
properties of the Starting block, a window will appear asking if you want to apply the changes to the
Starting block. Click Yes. The properties will be saved for the Starting block and the Hard Drive block
will become the active block. 

• For the Hard Drive block, make sure that the following options and properties have been defined in the
Block Properties window:

•  General Tab: Item Page

Block Name: Hard Drive 1
•  Reliability Tab: Failure Distribution Page

Block Can Fail: Selected
Failure Distribution: Weibull
Beta: 2.5
Eta: 3000 days
Gamma: 0
Static Reliability: Not Selected
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• Select the other Hard Drive block as the active block to define the Hard Drive 2 block properties. Be
sure that the following options and properties have been defined in the Block Properties window:

•  General Tab: Item Page

Block Name: Hard Drive 2
•  Reliability Tab: Failure Distribution Page

Block Can Fail: Selected
Failure Distribution: Exponential
Mean Time: 10000
Gamma: 0
Static Reliability: Not Selected

• Close the Block Properties window by clicking OK.

The Circuit Board block has already been defined with the failure characteristics of the Circuit Board
component. To verify this, you can select the block within the Diagram Sheet to view its failure distribution
in the Information area on the Diagram Sheet Control Panel that appears on the right side of the Diagram
Sheet or double-click the block to open the Block Properties window. 

At any point, you can change the properties of a block within the Diagram Sheet or within the Template
Panel. If you change the properties of a block within the Template Panel, then each time the block is dragged
into the Diagram Sheet, the block's properties will reflect the values specified in the Template. Changing the
properties of a block within the Template Panel will not, however, change the properties of blocks already
positioned in the Diagram Sheet, nor will changing the properties of blocks within the Diagram Sheet alter
the properties of blocks within the Template Panel.

• Now you are ready to connect the blocks to represent the relationships between the components of the
system. Use the Join Blocks tool to connect the Starting block to the Hard Drive 1 block, the Starting
block to the Hard Drive 2 block, the Hard Drive 1 block to the Circuit Board block and the Hard Drive
2 block to the Circuit Board block. When you use the Join Blocks tool to add relationship lines, be sure
to right-click the Diagram Sheet or click the Join Blocks icon once the relationships have been made in
order to return to BlockSim's normal mode. Your screen will look like the one shown next.1

1. Note that the relationship lines on your diagram may not appear identical to those shown in this Guide. To change the
appearance of relationship lines, click Options in the Graphics menu.
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Notice that the Hard Drive blocks are diagrammed in parallel to show that if one Hard Drive component
fails, the system will continue to operate with the other Hard Drive component. 

• Now that you have defined the reliability characteristics of each component block and arranged and
connected the blocks to represent the system, you are ready to analyze the system. To analyze the
system, select Analyze from the Tools menu or click the Analyze icon.

• Now you can generate plots based on the reliability characteristics of the entire system. Select
Analytical Plot from the Tools menu or click the Analytical Plot icon.

• If the Unreliability vs. Time plot is not displayed in the Analytical Plot Sheet by default, select
Unreliability vs. Time from the Plot Type drop-down menu on the Control Panel. The Unreliability vs.
Time plot will appear, as shown next.

• Return to the Diagram Sheet by clicking its page index tab.

As demonstrated in the First Steps example, BlockSim also allows you to obtain standard reliability results
based on the exact system reliability function. To calculate the reliability of the system at 730 days, the
Analytical Quick Calculation Pad (QCP) will be used. 

• Select Analytical QCP from the Tools menu or click the Analytical QCP icon.

• The Analytical QCP will appear. The QCP contains two pages, the General page and the Optimization
page. On the General page, select Std. Probability Calculations under System Calculations to
determine the reliability of the system.
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• Type a Mission End Time of 730 under Required Input from User. Finally, click Calculate and the
results of the calculation will appear under Results, as shown next.

You can see that the reliability of the system at 730 days is 0.9438 or 94.38%. Click Close to close the
Analytical Quick Calculation Pad and return to the Diagram Sheet.

BlockSim allows you to perform “what-if” calculations based on the RBDs you create. You can change the
status of individual blocks on or off to indicate whether the component is active or inactive and then obtain
reliability results for the system under those hypothetical conditions. 

• Next, you will determine the reliability of the system if Hard Drive 1 is turned off or absent from the
system. To switch the status of Hard Drive 1 to “off,” right-click the block and select Set Block to Off
from the shortcut menu that appears.2 A red X will appear on the block to indicate that the component is
inactive, as shown next.

• Now re-open the Analytical QCP. Select the Std. Probability Calculations option and specify 730 as
the Mission End Time. Click Calculate and the results will be displayed under Results. 

• You can see that with Hard Drive 1 inactive, the reliability of the system at 730 days decreases from
0.9438 (94.38%) to 0.8792 (87.92%). Close the Analytical QCP.

• Now switch the status of the Hard Drive 1 block back to “on” by de-selecting the Set Block to Off
option from the shortcut menu. The red X will disappear, indicating that the component is active.

BlockSim also provides the capability of reliability allocation calculations to determine the best way to
achieve a system reliability goal by improving the reliability of individual components. 

2. You can also click the block to select it and then select Set Block to Off from the Block menu.
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• Double-click the Hard Drive 1 block to open the Block Properties window. Click the Other tab  on the
left to display the Reliability Allocation page. On this page, you can define the optimization
characteristics of the selected component. Select the Block to be used in optimized allocation option
and enter 0.999 (default) into the Max Achievable Reliability input box. This option indicates the
highest reliability value that can reasonably be achieved for the component. 

• Drag the marker on the Feasibility scale to Moderate to indicate that it is moderately difficult (or
costly) to increase the reliability of the component.3 The window will look like the next figure.

• Click OK to return to the Diagram Sheet. A green box will appear at the bottom right corner of the
block, as shown next, to indicate that the reliability of this component is to be considered in the
optimization algorithm.

• Repeat these steps to define the optimization characteristics of the Hard Drive 2 and Circuit Board
blocks. For the Hard Drive 2 block, the Max Achievable Reliability is 0.999 and the Feasibility is Easy.
For the Circuit Board block, the Max Achievable Reliability is 0.999 and the Feasibility is Hard. Be
sure to select the Block to be used in optimized allocation option for both blocks.

3. You can also define your own cost function for the difficulty or cost of increasing the reliability of the block instead of
using the pre-defined Feasibility Scale by creating a feasibility policy.
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• Re-open the Analytical QCP and click the Optimization tab. The Optimization page allows you to set
up and run the allocation optimization algorithm for the system. For Mission End Time, type 730; for
Reliability Goal, type 0.98; for Iterations, accept the default value of 50.4 Select the Show Results
Automatically option, as shown next.

• Click Calculate to begin the optimization process.

• Because the Show Results Automatically option was selected in the Analytical QCP, when the
optimization calculations are complete, the results will appear in the Results Panel, as shown next.5

4. The Iterations input box allows you to enter the maximum number of iterations of the optimization algorithm to be
calculated in order to obtain a solution. As the complexity and number of units in the system increases, a greater number
of iterations may be required.
5. If the Show Results Automatically option is not selected, you can click the Report button to display the results in
ReliaSoft's Results Panel.
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The reliability goals for each optimized component, displayed in the R_goal(730) column, represent the
optimum scenario for increasing component reliability in order to achieve the system reliability goal of
0.98 (or 98%) while minimizing the system cost. The number of equivalent units that would have to be
placed in parallel to achieve this reliability is shown in the N.E.P.U. column, which stands for Number
of Equivalent Parallel Units. 

• Click Close in the Results Panel and again in the Analytical Quick Calculation Pad.

• If you are using a fully functional copy of the software (i.e. not a demonstration version), save the
project as Example1.rbp. To do this, click the Save icon or select Save from the File menu.

• In the Save As window, enter Example1 as the file name and click Save. After saving the file, leave the
project open, as it will be used in the next example.

4.2   Example 2: Optimized Reliability Allocation II
The Circuit Board from Example 1 was examined further to determine the major failure modes so that its
reliability could be improved. It was found that most of the failures were due to the failure of the Processor
and the Fan. The properties for the Processor and Fan are shown in the table below.

The Processor and Fan are connected reliability-wise in series. 

Do the following:

• Create an RBD for this subsystem.

• In the previous example, it was found that the reliability of the Circuit Board would need to be increased
from 0.9457 to 0.9806 for the system to reach a reliability goal of 0.98. Find the optimized reliabilities
for the Processor and Fan in order to achieve this goal.

Solution

• First, import an existing Diagram Sheet and Template from the Processor project.6 To do this, select
Import Items from the Project menu or right-click inside the Project Explorer and select Import Items
from the Project Explorer shortcut menu.

• The Select a project to import from window will open. Select the Processor.rbp file from the list of
files (in the BlockSim7\Examples\Training Guide directory) and click Open. 

• The Import window will appear. 

Component Failure 
Distribution Parameters Max Achievable 

Reliability
Feasibility of 

Increasing Reliability

Processor Weibull
Beta = 2.3

Eta = 7,655.19 days
Gamma = 0

.999 Moderate

Fan Exponential Mean Time = 14,231.83
Gamma = 0 .999 Easy

6. If you are using a restricted demo version of the software (i.e. one that cannot save files), you will not be able to
import items. For this example, you can manually create the RBD for the subsystem. Select Add Diagram from the
Project menu to create a new diagram, then add blocks, connect them and assign their properties based on the table and
instructions given in this example. 
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• On the right side of the window, select the Diagram2 diagram that appears under the Diagrams folder
and also select the Example2 Template that appears under the Templates folder, as shown next.7

• Click OK. The Diagram Sheet and Template will be imported into the project and your screen will look
like the one shown next.8

You can now see that two Diagram Sheets appear in the MDI and in the Project Explorer under the Diagrams
folder.

7. You can also select the box that appears next to the project file name at the top of the right side of the window to
indicate that you want to import all items that exist in the project.
8. If the Diagram2 Diagram Sheet does not appear in the MDI, double-click it in the Project Explorer to activate it.
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You can also see that two Templates, Example 1 and Example 2, appear in the Template Panel and in the
Project Explorer under the Templates folder. You can switch between Templates by clicking the
corresponding page index tab in the Template Panel or by double-clicking the Template name that appears in
Templates folder in the Project Explorer.

• Double-click the Processor block in the Diagram2 Diagram Sheet to open the Block Properties window.
Be sure that the Block Can Fail option is selected on the Failure Distribution page of the Reliability tab.

• Next, select Weibull as the failure distribution and enter the known parameter values from the table on
page 35. The window will look like the one shown next.
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• Now click the Other tab to display the Reliability Allocation page of the Block Properties window.
Select the Block to be used in optimized allocation option and type the proper values for the Max
Achievable Reliability (i.e. 0.999). Select the correct Feasibility option (i.e. Moderate), as shown next. 

• Select the Fan block as the active block. A window will appear asking if you want to apply the changes
to the Processor block. Click Yes. 

• The Fan block will become the active block. Enter the appropriate block properties for the Fan using the
same process described for the Processor (i.e. 0.999, Easy). After you have entered all of the properties,
click OK.
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• A green box will appear in the bottom right corner of the blocks in the Diagram Sheet to indicate that
the reliability of these components is to be optimized. Your screen will look like the one shown next.

• Analyze the system by selecting Analyze from the Tools menu or by clicking the Analyze icon.

• Next, optimize the reliabilities of the Processor and Fan so that the system reliability meets the
reliability goal of 0.9806. 
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• To do this, open the Analytical Quick Calculation Pad (QCP) and click the Optimization tab. Make
sure that 730 is entered for the Mission End Time, the Reliability Goal is set at 0.9806 and the number
of Iterations is 50 (default). In addition, make sure the Show Results Automatically option is selected.
The Analytical QCP will look like the next figure.

• Click Calculate to conduct the optimization calculations. The results are shown next.

As the results indicate, to achieve a reliability goal of 0.9806, the reliability of the processor must be at
least 0.9955 and the reliability of the fan must be at least 0.985.

• Click Close to close the Results Panel and click Close to close the Analytical QCP. If you are using a
fully functional copy of the software, save the project as Example2.rbp. Leave the project open, as it
will be used in the next example.

4.3  Example 3: Working with Subsystems
In BlockSim, you have the ability to include subsystems within selected blocks. This allows you to drill
down or view the subsystems within a particular component. This example will demonstrate this aspect of
BlockSim. At this point, you will still be working with the data and diagrams used in Examples 1 and 2.
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Do the following:

• Include the Fan and Processor as a subsystem within the Circuit Board block.

• Calculate the reliability of the system at 730 days.

Solution

• To begin, return the focus to Diagram 1. This is the diagram with two Hard Drives and a Circuit Board.
Double-click the Circuit Board block to open the Block Properties window.

• On the Subdiagram page of the General tab, select the Block As Diagram option. Below the Block As
Diagram option, a drop-down menu will appear. This menu contains a list of all available diagrams in
the current project. Select Diagram2 from this list. This is the diagram with the Processor and the Fan
that you were working with in Example 2. The window will look like the one shown next.

• Click OK to apply the current settings to the Circuit Board block and close the Block Properties
window.
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• The appearance of the Circuit Board block has now been modified. It still contains the original picture,
but it is now in the shape of a folder. This is the way that BlockSim identifies subdiagram blocks (blocks
that represent other diagrams).

The Circuit Board is now defined by the subsystem containing the Fan and Processor. In other words,
the block definition indicates that the Circuit Board is composed of one Fan and one Processor. This is
obviously an oversimplification; however, this example simply shows you how one block can represent
another diagram in BlockSim.

• To calculate the reliability of the system at 730 days, the QCP will be used. Select Analytical QCP
from the Tools menu or click the Analytical QCP icon.
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• Select Std. Probability Calculations under System Calculations. Type 730 for the Mission End Time
and click Calculate. The results are shown next.

The reliability of the system at 730 days is 0.9438 (94.38%), which is the same as the result returned in
Example 1.

• Close the Analytical QCP.

• If you are using a fully functional copy of the software, save the project.

• Close the project by selecting Close from the File menu.

4.4  Example 4: Integration with Weibull++ and Using Spreadsheets in
BlockSim
ACME Company manufactures subsystems for oil refinery plants. One of the subsystems that ACME
manufactures consists of two power generators, three pumps and one valve. The two generators are identical
to each other, as are the pumps. The pumps are in a 2-out-of-3 configuration. The system configuration is
shown next.

The following table presents the failure data for the generators.

Number in State State Time-to-Failure, hr
1 F 1,150
1 F 1,660
1 S 1,660

Generator

Generator

Pump

ValvePump

Pump
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The table shown next presents the failure distribution data and parameter values for the pumps and the valve.

Do the following:

• Using the Weibull++ software, determine an appropriate failure distribution for the generators based on
the given data.

• Estimate the parameters of the selected distribution using maximum likelihood estimation (MLE).

• Generate a table of system reliabilities given a start time of 1,000 hr and an end time of 5,000 hr with a
time increment of 1,000 hr.

Solution

• Create a new project. In the New Project Wizard, select to create the project based on the
Example4.rbb existing base project (in the BlockSim7\Examples\Training Guide directory) and
include a new blank Diagram Sheet. 

5 S 1,850
2 F 3,000
4 S 3,000
1 S 3,200
4 S 4,150
1 F 4,330
1 F 4,800
4 S 4,850
1 F 5,600
1 F 6,100
1 F 7,800
3 S 8,500
1 F 8,750
2 S 8,750
3 S 10,100
1 S 11,500
3 S 12,000

Component Failure Distribution Parameter Values

Pumps Mixed Weibull
(2 subpopulations)

1 = 0.589,  = 6,343.390 hr, Portion[1] = 0.2695

2 = 2.394,  = 20,301.856 hr, Portion[2] = 0.7305

Valve Exponential Mean Time = 830,288.94

β η1

β η1
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• The Project Explorer and a blank Diagram Sheet, along with the Template from the selected base
project, will open in the new project. Your screen will look like the one shown next.

• Double-click the Generator block inside the Template Panel. The Block Properties window will appear.
The properties for the Generator block have not been set. Although the parameter values are currently
unknown, life data has been obtained based on life tests conducted on the generator. This data, given in
the table on page 43, can be used to calculate the parameters of the failure distribution for the Generator
block.

• Be sure that you are on the Failure Distribution page of the Reliability tab of the Block Properties
window. Click the Compute parameters using Weibull++ button in the upper right corner. 
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• This will open the Select Weibull++ Folio window, which allows you to launch ReliaSoft's life data
analysis software, Weibull++.9 

• In the Select Weibull++ Folio window, click Create a New Data Folio.

• Once Weibull++ has been activated, the Weibull++ New Data Sheet Setup will appear. You will use the
New Data Sheet Setup to create the appropriate Data Entry Spreadsheet for the generator component's
life data. In the New Data Sheet Setup, select Times-to-failure data, My data set contains
suspensions (right censored data) and I want to enter data in groups. Click OK. A Data Entry
Spreadsheet will be created for you based on your selections. 

9. Weibull++ must be installed on your computer in order for you to use the Compute parameters using Weibull++
option.
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• Enter the failure data given for the Generator into the Data Entry Spreadsheet, as shown next.

• Maximum likelihood estimation (MLE) will be used for the parameter estimation. You can specify this
by clicking the Analysis tab on the Data Folio Control Panel. Select the Maximum Likelihood (MLE)
option from the Analysis Method area. Return to the Main page of the Control Panel by clicking the
Main tab.

• The Distribution Wizard utility in Weibull++ conducts a variety of goodness-of-fit tests designed to
suggest the best distribution for your data. Select Distribution Wizard from the Data menu or click the
Distribution Wizard icon.

• The Distribution Wizard will appear. Click Analyze so that the Distribution Wizard can go through the
process of suggesting a distribution. After the Distribution Wizard has finished conducting the tests, the
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two-parameter exponential distribution will be suggested (indicated by the 1 in the Ranking column
next to Exponential 2), as shown next.10

• Click Implement to indicate that you would like to calculate the parameters using the two-parameter
exponential distribution. The Distribution Wizard will close and you will now be viewing the Data
Entry Spreadsheet with the entered data and the parameters calculated, as shown next.

10.Note that the results shown here assume that you are using the default settings shipped with the software. Changing
these settings may lead to different results. To reset your software to the default settings, click the Reset All Settings
button on the Other page of the User Setup.
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• Click the Transfer and Close button to transfer the calculated data to BlockSim and close Weibull++..
A message box will appear to ask if you would like to save the changes made to the Weibull++ project.
Click Yes and save the Data Folio as Example4.rwp. 

• Notice that the parameter values that were calculated using Weibull++ have been inserted as the
parameter values of the failure distribution of the Generator block, as shown next. Click OK to accept
the current block properties. 

• Now you will arrange the blocks in the diagram. Because BlockSim's diagrams must have only one
starting point, you will use the Starting block as the starting point of the diagram. Place the Starting
block on the left side of the diagram. Drag one Generator block into the diagram and place it above and
to the right of the Starting block. Drag another Generator block into the diagram and place it below and
to the right of the Starting block. Drag the Pump block into the diagram three times, placing each of
them in a vertical line to the right of the Generator blocks. Drag the Valve block into the diagram and
place it on the far right side. 

• Your diagram will look like the one shown next.

Now you will connect the blocks by dragging relationship lines between them. Connect the Starting block to
each of the Generator blocks.11 The Generator blocks will be connected to each of the Pump blocks through
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a Node block. A Node block is a different type of block that can be defined to indicate the number of paths
that must successfully pass through the block in order for the system to succeed (k-out-of-n).

•  To place a node into the diagram, select Add Node to Diagram from the Diagram menu or click the
Add New Node icon.

• A Node block will appear in the Diagram Sheet. Place the Node block between the Generator blocks
and the Pump blocks. Your screen will look like the one shown next. 

• Double-click the Node block to open the Node Properties window.

11.Remember to right-click or double-click the Diagram Sheet or click the Join Blocks icon again once the relationships
have been made in order to return to BlockSim’s normal mode. 
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• On the Item page of the General tab, in the Number of Paths Required input box, type 1, to indicate that
one working generator is required in order for the system to succeed, as shown next.

• Make sure the Block Can Fail option is not selected on the Failure Distribution page of the Reliability
tab.12 Click OK to close the Node Properties window. 

• Connect each Generator block to the Node block and then connect the Node block to each Pump block.
Your screen will look like the one shown next.

• You will also use a Node block to represent the k-out-of-n configuration of the Pump blocks in relation
to the Valve block. Place a Node block between the Pump blocks and the Valve block. Double-click the
Node block to open the Node Properties window. In the Number of Paths Required box, type 2 to
indicate that two working pumps are required in order for the system to operate. Make sure the Block

12.If the Block Can Fail option is selected, you can define the failure properties for the Node block.
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Can Fail option is not selected on the Failure Distribution page of the Reliability tab. Click OK to close
the Node Properties window. 

• Now connect each Pump block to the Node 2 block and connect the Node 2 block to the Valve block.
Your diagram will look like the one shown next.

• Analyze the system by selecting Analyze from the Tools menu or by clicking the Analyze icon.

• Insert a new Spreadsheet into the project by selecting Add Spreadsheet from the Project menu or from
the Project Explorer shortcut menu. A Spreadsheet will appear in the MDI. You can also see that the
Spreadsheet has been added to the Project Explorer under the Spreadsheets folder. 

• From the Spreadsheet, you will use the Function Wizard to generate a table of system reliabilities. Open
the Function Wizard by selecting Function Wizard from the Spreadsheet menu or by clicking the
Function Wizard icon.

• Scroll through the list of available functions and select Table of Reliabilities given a time range. Type
1000 for the Iter. Start Time, 5000 for the Iter. End Time and 1000 for the Iteration Incr. in the input
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boxes. Make sure that Diagram 1 is selected from the Data Source drop-down menu. The Function
Wizard should look like the one shown next.

• Click OK to generate the table in the Spreadsheet, as shown next.

• If you are using a fully functional copy of the software, save the project as Example4.rbp.

• Close the project.
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4.5  Example 5: Estimating Reliability, Downtime and Maintenance Costs
Consider the following telecommunications network:

The letters A-E represent the Communication Centers, where A is the main Center. F is a City to which
service is being supplied. The numbers 1-8 represent the Communication Lines. Communication Lines 3
and 6 can operate in two directions (e.g. from B to D and from D to B). The Communication Centers cannot
fail, while the failure rate ( ) for the Communication Lines is 1.3E-4 failures/hour. The repair distribution
for the Communication Lines is normal with a mean time of 101.35 hr and a standard deviation of 62.1 hr.
The cost of each Communication Line is $1,000 and the labor cost for replacing a line is $75/hr.

Do the following:

• Create the RBD and use mirrored blocks for the Communication Lines that operate in two directions.

• Find the reliability of the system at 6 months.

• Find the estimated time at which 25% of the Communication Systems that are in operation will have
failed.

• Using simulation, estimate the total downtime for the system for one year (8,766 hr) and the
maintenance costs.

Solution

• Create a new project. In the New Project Wizard, select to create a new project based on the existing
base project Example5.rbb (located in the BlockSim7\Examples\Training Guide folder) and select to
add a new blank Diagram Sheet.

• The selected base project will open in the new project and the Example5 Template will appear in the
Template Panel. 

λ
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• The Project Explorer and a blank Diagram Sheet will also appear. Your screen will look like the one
shown next.

• For this example, the exponential parameter will be defined as “lambda” instead of “mean time.” To
define the exponential parameter as lambda, select User Setup from the File menu to open the User
Setup window. 

• Click the Calculations tab to display the Calculations page of the User Setup and de-select the Use
Mean Time for the Exponential distribution option at the bottom of the window, as shown next.

When the Use Mean Time for the Exponential distribution option is not selected, you will be
prompted to enter a value for lambda each time you define a block with the exponential distribution.

• Click OK to close the User Setup window.

• Double-click the Com Center block in the Template to open the Block Properties window. The Com
Centers designated by the letters A-E cannot fail. Therefore, make sure the Block Can Fail option is not
selected on the Failure Distribution page of the Reliability tab and click OK. 

• Now double-click the Com Line block. The failure distribution associated with each Communication
Line is the exponential distribution. On the Failure Distribution page, select Exponential under Failure
Distribution. Enter 1.3E-4 for the value of lambda and 0 for the value of gamma. 
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• Click the Maintenance tab to open the Corrective page of the Block Properties window. Click to select
the Can Maintain Correctively option. The corrective maintenance distribution options will become
available. Select Normal as the corrective maintenance distribution and enter 101.35 for the mean value
and 62.1 for the Std value, as shown next.

• Next, assign a crew to perform corrective maintenance on the block by clicking the Assign button in the
Corrective Maintenance Crews area in the upper right corner of the window. 

• The Select Crew window will appear.13 Click New to create a new crew.

13.At this time, the Select Crew window will not display any crews to be selected since no crews have been defined in
the current project. Once you have defined crews in a project, the crews will appear in this window and you can select
the crews that you want to assign to perform the maintenance.
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• In the Crew Policy window that appears, type Crew Policy1 for the Policy Identifier and type 75 for the
Direct Cost per Unit Time, as shown next. This indicates that it costs $75 per hour for the crew to
perform maintenance.

The Simultaneous Tasks area of this window allows you to specify how many simultaneous tasks the
crew can perform and the Logistic Delays area allows you to indicate that there is a delay time before
the crew can start the task. For this example, accept the default selections for both areas (i.e. No should
be selected for Simultaneous Tasks and the Add Logistic Delay option should not be selected).

• Click OK in the Crew Policy window. 

• The Select Crew window will reappear. Verify that Crew Policy1 is selected, as shown next.

• Click OK. Notice that the crew policy appears in the Corrective Maintenance Crews area of the Block
Properties window.

• Next, assign a spare part pool for the block by clicking the Create New Spare Part Pool button in the
Spare Part Pool area in bottom right corner of the Block Properties window. 
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• The Spare Part Pool Properties window will appear. Type Spare Pool Policy1 for the Policy Identifier
and type 1000 for the Direct Cost per Item, as shown next. This indicates that it costs $1,000 per spare
part.

Accept the default selections for the rest of the options in this window. The Indirect Cost per Item per
Unit Time in Pool input box allows you to specify the indirect costs of maintaining the spare part in the
pool over time. This should be set to 0. The There are infinite spares in this pool option allows you to
specify if there is an unlimited number of spare parts in the pool. This option should be selected. The
Spare parts are limited option allows you to specify if there is a limited number of spare parts in the
pool. This option should not be selected. The Add Logistic Time for Spare Acquisition area allows
you to specify the amount of time required to obtain the part when it is required for maintenance. This
option should not be selected.

• Click OK in the Spare Part Pool Properties window. Notice that the policy appears in the Spare Part
Pool area of the Block Properties window.

• Next, select the City block as the active block. As is the case for the Com Centers, the City cannot fail.
De-select the Block Can Fail option on the Failure Distribution page of the Reliability tab and click
OK.

The Communication Lines are the most important blocks in this example. The Communication Centers
cannot fail and will be used as Node blocks within the RBD. They will be used to direct the Communication
Lines. When constructing the RBD, be sure to change the name of each Com Line and Com Center block
within the diagram to represent the proper Communication Line and Communication Center. You can
change the name of the block by double-clicking it to open the Block Properties window. Designate each
Communication Center as Center A, Center B, etc. Designate each Communication Line as Com 1, Com 2,
etc.
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A representation of the RBD to be constructed is shown next.

Because Communication Lines 3 and 6 flow in two directions, multiple representations of Communication
Lines 3 and 6 must be included in your RBD, as shown above. A relationship line within BlockSim cannot
flow in two directions at the same time. In other words, there can be no circular paths. 

You can use mirror blocks to represent these blocks. Mirror blocks can be used to represent a single item
with more than one block placed in multiple locations within the diagram. Mirror blocks can be used to
simulate bi-directional paths within a diagram. When simulation is performed on a Diagram Sheet with
mirror blocks, every event associated with the “source” block will be exactly the same for every event
associated with the “mirror” block(s). 

• To create a mirror block for Communication Line 3, select the Communication Line 3 that flows to
Communication Center D in the Diagram Sheet and select Mirror Block from the Block menu or click
its icon.

• The mouse pointer will turn into a mirror when it is above a block. Next, click the Communication Line
3 block in the Diagram Sheet that flows to Communication Line 4. The properties of the “source”
Communication Line 3 block will be mirrored in the “target” Communication Line 3 block. A grey box
will appear at the top left corner of the “target” block, as shown next, to indicate that the block is a
mirror block.

• Repeat these steps to create a mirror block for Communication Line 6.
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• The RBD constructed using mirror blocks is shown next.

• Analyze the system by selecting Analyze from the Tools menu or by clicking the Analyze icon.

• The Analytical Quick Calculation Pad (QCP) will be used to calculate the reliability of the system. To
access the Analytical QCP, select Analytical QCP from the Tools menu or click the Analytical QCP
icon.

• Select Std. Probability Calculations under System Calculations. Type 4383 for the Mission End Time
and click Calculate to return the system reliability, as shown next.

The reliability of the system at 4,383 hr is 0.4473 (44.73%).
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• The second question requires the time at which 25% of the Communication Systems in operation will
have failed. Select BX Information under System Calculations. Type 25 in the BX% Information At
input box and click Calculate to return the result, as shown next.

The time at which 25% of the Communication Systems will fail is approximately 2,458.165 hr. 

• Close the Analytical QCP by clicking Close.

• You will now use BlockSim's Maintainability/Availability Simulation utility to analyze the system for
one year of operation and to estimate the system costs.14 Select Simulate from the Tools menu or click
the Simulate icon.

• The Maintainability/Availability Simulation window will open.

• On the General page, type 8766 for the End Time. Type 10 for the Increments, which allows you to
specify the intervals at which point availability results will be calculated. The application will divide
8766 by 10 and report the point results at 10 equal increments (i.e. at 876.6, 1,753.2, etc.).

• Select the Use a Seed option and type 1 for the seed value. Using a seed for the simulation allows you to
replicate these results.

14.The calculations performed in the Analytical QCP are based only on the failure information of the components. The
Maintainability/Availability Simulation utility uses the failure and maintenance information of the components in order
to obtain such results as point availability, mean availability, etc.
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• Select the Fixed number of Simulations option and type 1000 in the Number of Simulations input box,
which allows you to specify the number of simulations to be performed to obtain a solution. The
window should look like the one shown next.

• Click Simulate to begin the simulation. While the simulation is being performed, the appearance of the
Maintainability/Availability Simulation window will change to show the status of the simulation, as
shown next.
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• When the simulation is complete, you can click the Details button in the Maintainability/Availability
Simulation window to view the simulation results in the Simulation Results Explorer, as shown next. 

The Simulation Results Explorer contains a Control Panel on the left side of the window, which allows you
to view the simulation results for the entire system, for each block, for the crews and spare pool policies and
for the simulation settings on separate worksheets. Click an element in the Control Panel to view its
simulation results in a worksheet.

• For this example, you can see from the second worksheet in the Results Explorer, the System Overview
worksheet, that the downtime for the system is 4.9828 hr of the 8,766 total hours.15 

15.Please note that these results may vary since they are based on simulation.
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• Next, click the System Costs worksheet in the Control Panel to view the maintenance costs for the
system, as shown next.

The total system cost for corrective maintenance is estimated to be $78,077.06.

• Return to the System Overview worksheet. These results can be transferred to a Spreadsheet by clicking
the Transfer to Spreadsheet icon.
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• The Select Spreadsheet window will appear, which allows you to select the Spreadsheet you want to
transfer the results to or to create a new Spreadsheet.16 For this example, type “Spreadsheet 1” for the
Spreadsheet name in the input box at the top of the window, as shown next.

• Click OK. 

• Close the Simulation Results Explorer and the Maintainability/Availability Simulation window. You
can see that Spreadsheet 1 has been added to the project and appears in the Project Explorer under the
Spreadsheets folder. 

• If you are using a fully functional copy of the software, save the project as Example5.rbp.

• Close the project.

4.6  Example 6: Fault Tree Analysis
This example demonstrates the integrated fault tree analysis capabilities available in BlockSim 7.

There are five independent events (sub-modes) associated with a particular failure mode, Mode A. It is
assumed that events S1, S2 and Y each have a constant rate of occurrence (exponential distribution). Events
T1 and T2 are more likely to occur in an older component than in a newer one. Specifically, the following
probabilities are assumed:

There are three possible ways for Mode A to manifest:

•  Events S1 and S2 both occur.

•  Event T1 or event T2 occurs.

•  Event Y and either event S1 or S2 occur (i.e. Y and S1 or Y and S2)

16.For this example, you must create a new Spreadsheet since the current project does not contain any existing
Spreadsheets to transfer the results to.

Event Failure Distribution Parameter Values
S1 Exponential Mean Time = 87,595,619
S2 Exponential Mean Time = 175,195,619
T1 Weibull  = 3.32,  = 140081
T2 Weibull  = 2.74,  = 326469
Y Exponential Mean Time = 8,755,619

β η

β η
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Do the following:

• Create a fault tree diagram for Mode A.

• Create a reliability block diagram for Mode A.

• Use the QCP to estimate the reliability at five years (43,800 hr).

Solution:

• Create a new project. In the New Project Wizard, select to create a new blank project and select to add a
new blank Fault Tree.

• The new project will appear, as shown next.

• By default, the top gate is an AND gate. Since Mode A can manifest in any of three ways, the top gate
in your fault tree will be an OR gate. You can change the gate by right-clicking on it and choosing
Convert Block To then OR Gate from the shortcut menu that appears.

• Double-click the gate, or right-click it and select Edit Block Properties, to open the Gate Properties
window. On the Comments and Attachments page, type Mode A Failure in the Comments area and
click OK to close the window.

• It is possible to model the information in this example in more than one way. To create the simplest fault
tree, notice that events S1, S2, and Y must always occur in some combination to cause Mode A failure.
This is a two-out-of-three configuration, and can be represented by a Voting Gate. Make sure the top
gate is selected, then add a Voting Gate to the fault tree, either by selecting Add Gate then Voting Gate
from the Fault Tree menu or by clicking on the Voting Gate icon.
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• The Voting Gate will automatically be connected to the top gate. (If the top gate had not been selected
when you added the Voting Gate, there would be no connection.) You can drag the new gate to
reposition it where you want it.

• With the Voting Gate selected, add three Basic Events, either by selecting Add Event then Basic Event
from the Fault Tree menu or by clicking on the Event icon. This icon has a drop-down menu, from
which you can select event types, but if you click the icon itself, a Basic Event will be added. 

• Your fault tree will now look like the one shown next.

• For each event, rename and define its properties using the the Event Properties window, opened by
double-clicking on the event. You will need to name the event on the Item page of the General
Properties tab and to specify the reliability parameters on the Reliability tab.17

17.If the exponential parameter is still defined as “lambda” instead of “mean time,” you will need to go back into User
Setup to change this.
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• Double-click on the Voting Gate to open the Gate Properties window. On the Item page of the General
tab, rename the gate to 2/3. Input 2 for the Vote Number, to indicate that two of the three events under
the gate must occur.

• Using the same procedures, add an OR Gate and events T1 and T2. Your final fault tree will look like
the one shown next.
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• As noted earlier, this information can be represented with a different fault tree, with a separate gate for
each of the three possible ways for Mode A to manifest. This fault tree, involving the use of mirrored
events, looks like the one shown next. You do not need to create this fault tree.

• It is possible to create a reliability block diagram directly from your fault tree diagram. To do this, select
Create RBD from the Fault Tree menu. BlockSim will automatically create the RBD, using all of the
parameters you supplied. Your screen will look like the one shown next.

• Return to the fault tree diagram and open the Analytical QCP. Note that when you do this, BlockSim
automatically analyzes the system.
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• Select Std. Probability Calculations under System Calculations. Type 43800 for the Mission End Time
and click Calculate to return the system reliability, as shown next.

The reliability of the system at 43,800 hr is 0.9752 (97.52%).

• If you are using a fully functional copy of the software, save the project as Example6.rbp.

• Close the project.

4.7  Example 7: Phase Diagrams I
This example demonstrates the use of reliability phase diagrams in BlockSim.

Consider a race car that competes in 200-mile races. Assume that the main components of the race car are:

• The engine
• The transmission
• The front and rear suspensions
• The brakes 

All of these components can be considered to be in a reliability-wise series configuration and are
correctively replaced upon failure. In the event of a failure, the race car drops out of the race, undergoes
repairs and waits for the next race. After each race, the brakes are preventively replaced while the other
components remain on the car for the next race. If any one of the front or rear brakes fail during the race, all
other brakes on the car are also preventively replaced. For this example, suppose that the performance of the
race car needs to be analyzed for ten consecutive races using the component failure and repair properties
given in the table that follows. All corrective and preventive maintenance actions are assigned durations of
0.0 miles. This is done because the analysis of the race car is carried out in the units of miles. Since no miles
are accumulated while maintenance is performed on any of the components of the race car, these actions can
be considered instantaneous for the purposes of the analysis.

Component Failure CM 
duration

PM 
duration

CM 
cost

PM 
cost

Engine W(2.82, 906) 0.0 None 328500 None
Transmission W(3.14, 1737) 0.0 None 118600 None
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Do the following:

• Find the mean availability of the race car for the ten-race mission.

• Estimate the number of failures of the race car for the mission and the spares required for each
component.

• Estimate the total miles lost due to the failures.

• Estimate the maintenance cost of operating the race car for such a mission and maintenance cost for
each individual component.

• Obtain the point reliability plot of the race car for the mission.

Solution:
In order to correctly model the race car analysis in BlockSim, reliability phase diagrams have to be used. An
operational phase should be used to represent each of the 200-mile races. The race car RBD can be linked to
this phase. However, no maintenance properties are defined for any of the components in this phase as it is
not possible to fix failures during a race. Instead, a maintenance phase follows the operational phase and
represents the period of time spent in corrective or preventive maintenance of the race car. The “Continue
simulation” option should be selected for the “On System Failure” property of the operational phase. This
will ensure that miles lost when the race car drops out of a race because of a system failure are recorded as
downtime by the simulation. Moreover, a PM policy needs to be defined for the brake blocks. The policy
will model scheduled replacement of all brakes after each race (using the “Upon Start of a Maintenance
Phase” option) and also takes into account the scenario when failure of one brake during a race leads to
replacement of the other three brakes (using the “Upon Maintenance of another Group Item” option).

• Create a new project. In the New Project Wizard, select to create the project based on the
Example7.rbb existing base project (in the BlockSim7\Examples\Training Guide directory) and
include a new blank Diagram Sheet. 

Suspension 
Front

L(7.2903, 
0.6521)

0.0 None 63900 None

Suspension 
Rear

W(2.46, 1564) 0.0 None 63900 None

Brakes Front R W(3.22, 716) 0.0 0.0 40000 7000
Brakes Front L W(3.22, 716) 0.0 0.0 40000 7000
Brakes Rear R W(15.36, 391) 0.0 0.0 40000 7000
Brakes Rear L W(15.36, 391) 0.0 0.0 40000 7000
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• The selected base project will open in the new project and the Example7 Template will appear in the
Template Panel. The Project Explorer and a blank Diagram Sheet will also appear. Your screen will look
like the one shown next.

• Use the Template blocks to create the RBD for the race car, as shown next.

• Note that you do not need to enter the failure properties for each block in the diagram, as they were
already defined for the Template blocks.

• Add a new Maintenance Template Sheet to the project by selecting Add Maintenance Template from
the Project menu. 
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• Add one instance of each block from the Template Panel to the Maintenance Template, as shown next.

Note that the order in which the blocks are added to the Maintenance Template Sheet determines their
priority number, which is displayed in parentheses after the block name. The priority order decides the
order of maintenance actions on the blocks if the blocks share one or more resource(s). If you need to
change the priority order, you can click the Set Maintenance Priority button in the Maintenance
Template Control Panel to open the Set Maintenance Priority window, which allows you to move the
blocks up and down in the priority list. The priority order for this example should be:

1. Engine
2. Transmission
3. Suspension Front
4. Suspension Rear
5. Brakes Front R
6. Brakes Front L
7. Brakes Rear R
8. Brakes Rear L

• For each block in the Maintenance Template Sheet, open the Block Properties window, enable the
appropriate maintenance type(s) and make sure the repair properties given in the table are entered on the
Maintenance tab. For the brake blocks, you will need to enable both corrective and preventive
maintenance; for all other blocks, you will enable only corrective maintenance.

• Create a new preventive maintenance policy for the brake blocks by selecting Add New Resource then
Add Preventive Policy from the Project menu. In the Preventive Maintenance Policy window that
appears, select to perform preventive maintenance both upon maintenance of another group item and
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upon start of a maintenance phase and select not to perform the maintenance if the action brings the
system down, as shown next.

• For each brake block in the Maintenance Template Sheet, add the preventive maintenance policy on the
Preventive page of the Maintenance tab. In addition, make sure the Item Group # is set to 1 for each
brake block.

• Add a new Phase Diagram Sheet to the project by selecting Add Phase Diagram from the Project
menu.

• Add an operational phase to the Phase Diagram Sheet by selecting Add Operational Phase from the
Phase Diagram menu or by clicking the Add Operational Phase icon.

• When the phase appears in the Phase Diagram Sheet, double-click it to open the Phase Properties
window. In the Phase Properties window, name the phase Race and associate it with the RBD you built
for the race car in Diagram1. Enter a phase duration of 200, a phase duty cycle of 1 and select to
continue simulation on system failure, as shown next, then click OK.
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• Add a maintenance phase to the Phase Diagram Sheet by selecting Add Maintenance Phase from the
Phase Diagram menu or by clicking the Add Maintenance Phase icon.

• In the Phase Properties window for the new maintenance phase, name the phase Maintenance and
associate it with the maintenance template you created. Leave the System Age Threshold value at 1, as
shown next, then click OK.

• Join the phases in the Phase Diagram Sheet, as shown next.

• Select Simulate from the Tools menu or click the Simulate icon.

• The Maintainability/Availability Simulation window will open.

• On the General page, type 2000 for the End Time and 20 for the Increments. Select the Use a Seed
option and type 1 for the seed value. Using a seed for the simulation allows you to replicate these
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results. Select the Fixed number of Simulations option and type 1000 in the Number of Simulations
input box, as shown next.

• Click Simulate to begin the simulation. When the simulation is complete, you can click the Details
button in the Maintainability/Availability Simulation window to view the simulation results in the
Simulation Results Explorer, as shown next. 
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From the System Overview worksheet shown above, you can see the following (note that your results may
vary slightly, depending on the IDs assigned to the blocks by BlockSim):

• The mean availability of the race car for the ten race mission is 80.76%.

• The expected number of failures for the race car during the ten races is 3.833.

• The downtime, representing the number of miles lost by the race car due to failures, is 384.7318.

• The total cost, representing the maintenance cost of the race car for the ten races, is $856,456.40. 

Information on individual components can be obtained from the Block Summary worksheet, as shown next.

Note that you will need to scroll to the right to view the results of interest displayed here.

• The spares required for each component, obtained by adding the number of CMs and the number of
PMs, are as follows:

•  Engine: 1.407

•  Transmission: 0.491

•  Suspension Front: 0.551

•  Suspension Rear: 0.656

•  Brakes Front R: 9

•  Brakes Front L: 9

•  Brakes Rear R: 9

•  Brakes Rear L: 9

• The maintenance costs for each component, equal to the total cost for each component, are:

•  Engine: $462,199.50

•  Transmission: $58,232.60

•  Suspension Front: $35,208.90

•  Suspension Rear: $41,918.40

•  Brakes Front R: $66,795.00

•  Brakes Front L: $66,102.00

•  Brakes Rear R: $63,000.00

•  Brakes Rear L: $63,000.00
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For an overview of the race car’s reliability as a function of time, you can generate a point reliability plot.

• Close the Simulation Results Explorer and the Maintainability/Availability Simulation window.

• Create a simulation plot by selecting Simulation Plot from the Tools menu or by clicking the
Simulation Plot icon in the Phase Diagram Sheet Control Panel.

• Select Point Reliability from the Plot Type drop-down menu, if it is not already selected. If Auto
Refresh is selected in the Control Panel, the Plot Sheet will be automatically updated to display the plot
type you have selected. Otherwise, you can click the Redraw Plot icon to refresh the plot.

The point reliability plot is shown next.

• If you are using a fully functional copy of the software, save the project as Example7.rbp.

• Close the project.

4.8  Example 8: Phase Diagrams II
This example illustrates the use of reliability phase diagrams along with various phase properties. 

Consider a production facility that has been analyzed using Weibull++’s recurrence data analysis
functionality. It has been found to follow a power law model with Beta = 1.55, Lambda = 1.91E-4 and q =
0.35 (type I). From the relation: 

 
we can model this in BlockSim 7 using a block following a Weibull distribution with Beta = 1.55 and Eta =
250.4 and a restoration factor of 0.65. The plant's mean outage has been reported as 12 days. 
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Every time the plant shuts down due to an outage, the throughput of the plant goes through a warm-up
period of 5 days until it reaches capacity again. The throughput per day can be described as follows:

y(x) =   20 * x (within warm up, t <= 5)

y(x) = 100 (during normal operation, t > 5)

In addition, during this warm up period, the components work under a 50% higher stress than during normal
operation.

Preventive maintenance will be performed on the facility after a year of normal operation without outages.
Planned maintenances take 5 days and have been found to be 70% effective in restoring the system's damage
(assume type I restoration).

Do the following:

• Find the mean availability for this facility over the next three years with weekly results.

• Plot the point availability of the system for that time.

• Determine the throughput of this plant at the end of the 3 years.

• Discuss point results vs. mean results.

• Export results to a general spreadsheet and plot production vs. time.

• Create a table calculating the throughput per week and plot weekly production vs. time.

Solution:

• Create a new project. In the New Project Wizard, select to create a new blank project and select to add a
new blank Diagram Sheet.

• The new project will appear, as shown next.
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• Add a block to the diagram. In the Block Properties window for the new block, name the block Plant.
On the Reliability tab, specify a Weibull distribution with Beta = 1.55 and Eta = 250.4, as shown next.

• On the Throughput page of the Other tab, enter a throughput of 100 units per day and specify to Ignore
backlog, as shown next, then click OK.

• Add a new Maintenance Template Sheet to the project by selecting Add Maintenance Template from
the Project menu. 

• Add a block to the Maintenance Template. In the Block Properties window for the new block, name the
block Plant.
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• On the Corrective page of the Maintenance tab, select the Can Maintain Correctively option. Specify
an exponential distribution with Mean Time = 12 and Gamma = 0 and a type I restoration factor of
0.65, as shown next.

• On the Preventive page of the Maintenance tab, select the Can Maintain Preventively option. Specify
an exponential distribution with Mean Time = 5 and Gamma = 0 and a type I restoration factor of 0.7,
as shown next, then click OK.

Note that the preventive maintenance policy should be left at the default setting. In a maintenance
phase, the default setting is to begin maintenance upon start of the phase (as opposed to standard phases,
in which the default setting is to begin maintenance upon system down).

• Add a new Phase Diagram Sheet to the project by selecting Add Phase Diagram from the Project
menu.
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• Add two operational phases to the Phase Diagram Sheet by selecting Add Operational Phase from the
Phase Diagram menu or by clicking the Add Operational Phase icon.

• Add a maintenance phase to the Phase Diagram Sheet by selecting Add Maintenance Phase from the
Phase Diagram menu or by clicking the Add Maintenance Phase icon.

• Double-click the first operational phase to open the Phase Properties window. On the General tab of the
Phase Properties window, name the phase Warm Up Period and associate it with the RBD you built in
Diagram1. Enter a phase duration of 5 days and a phase duty cycle of 1.5 (which reflects the fact that
the components work 50% harder during warm up). Select Go to maintenance phase from the On
System Failure drop-down menu, then select the maintenance phase (Phase 3, if you added the phases
in the order specified) from the Go to Phase drop-down menu, as shown next.18

18.Note that these settings specify that if a system failure occurs during the warm up period, this phase will be
interrupted, any other operational phases (in this case, the Normal Operation phase) will be skipped and execution of the
maintenance phase will start immediately.
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• On the Phase Throughput tab of the Phase Properties window, select Variable Throughput. Specify a
linear model with a = 20, b = 0 and Maximum Throughput Capacity = 100, as shown next.

• In the Active Phase field at the bottom of the Phase Properties window, select the second operational
phase (Phase 2, if you added the phases in the order specified) to edit its properties. Select to apply your
changes when prompted. 

• On the General tab of the Phase Properties window, name the phase Normal Operation and associate it
with the RBD you built in Diagram1. Enter a phase duration of 360 days and a phase duty cycle of 1.
Select Go to maintenance phase from the On System Failure drop-down menu, then select the
maintenance phase (Phase 3, if you added the phases in the order specified) from the Go to Phase drop-
down menu, as shown next.

• On the Phase Throughput tab of the Phase Properties window, select Constant Throughput and
specify a throughput of 100.

• In the Active Phase field at the bottom of the Phase Properties window, select the maintenance phase
(Phase 3, if you added the phases in the order specified) to edit its properties. Select to apply your
changes when asked. 
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• On the General tab of the Phase Properties window, name the phase Maintenance and associate it with
the Maintenance1 maintenance template, as shown next, then click OK.

• Join the phases in the Phase Diagram Sheet, as shown next.

• Select Simulate from the Tools menu or click the Simulate icon.

• On the General page, type 1092 (i.e. 3 years x 52 weeks x 7 days) for the End Time and 156 for the
Increments, for weekly results. Select the Use a Seed option and type 1 for the seed value. Using a seed
for the simulation allows you to replicate these results. Select the Fixed number of Simulations option
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and type 1000 in the Number of Simulations input box then select Run Throughput Simulation, as
shown next.

• On the Throughput Settings page of the Maintainability/Availability Simulation window, select Report
Throughput Point Results, as shown next.
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• Click Simulate to begin the simulation. When the simulation is complete, you can click the Details
button in the Maintainability/Availability Simulation window to view the simulation results in the
Simulation Results Explorer, as shown next. 

From the System Overview worksheet shown above, you can see the following (note that your results may
vary slightly, depending on the IDs assigned to the blocks by BlockSim):

• The mean availability of the system for the next three years is 93.12%.

• The expected throughput of the plant at the end of three years is 99,809.4201.

For an overview of the plant’s availability as a function of time, you can generate a point availability plot.

• Close the Simulation Results Explorer and the Maintainability/Availability Simulation window.

• Create a simulation plot by selecting Simulation Plot from the Tools menu or by clicking the
Simulation Plot icon in the Phase Diagram Sheet Control Panel.

• Select Point Availability from the Plot Type drop-down menu, if it is not already selected. If Auto
Refresh is selected in the Control Panel, the Plot Sheet will be automatically updated to display the plot
type you have selected. Otherwise, you can click the Redraw Plot icon to refresh the plot.
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The point availability plot is shown next.

From the results and this plot, it can be seen that initially, mean results underestimate point results while as
time goes by, they overestimate them. Mean results in this case are unable to describe the degrading nature
of the model describing the system (i.e. restoration factor of type I that is less than 100% effective).

• Return to the Phase Diagram Sheet by clicking its page index tab.

• Click the Show Simulation Details icon (...) in the Control Panel to return to the Simulation Results
Explorer.

• Select the System Point Results worksheet in the Control Panel and click the Transfer to Spreadsheet
icon.

• The Select Spreadsheet window will appear, which allows you to select the Spreadsheet you want to
transfer the results to or to create a new Spreadsheet.19 For this example, type Point Results for the
Spreadsheet name in the input box at the top of the window and click OK. 

• Close the Simulation Results Explorer and then open the Point Results spreadsheet that has been added
to the project and appears in the Project Explorer under the Spreadsheets folder. 

• Select columns B through I by clicking the column header for column B and dragging across to the
column header for column I, then right-click in the spreadsheet area and select Delete then Entire

19.For this example, you must create a new Spreadsheet since the current project does not contain any existing
Spreadsheets to transfer the results to.
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Column from the shortcut menu that appears. The spreadsheet will look like the one shown next (note
that not all rows of data are displayed here).

• The next step is to create a table displaying the throughput per week so that you can plot weekly
production vs. time. To do this, enter Weekly Production in cell D1 and Weeks in cell D2. Enter 1 in
cell D3, then enter the function =D3+1 in cell D4.  Select cell D4 and position the cursor over the black
box at the lower right corner of the cell, as shown next.

• Click and drag the box down to cell D158, thereby populating each cell with a function that adds 1 to
the value of the previous cell. To format the column, select column A by clicking the column header
then click the Format Painter icon.
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• Click the column header of column D to apply the formatting you have just copied from column A. The
spreadsheet will look like the one shown next.

• To create the column for weekly production values, enter the function =B3 in cell E3, then enter the
function =B4-B3 in cell E4. Select cell E4, and position the cursor over the black box at the lower right
corner of the cell and click and drag the box down to cell E158, thereby populating each cell with a
function that subtracts the value of the previous cell in column B from the value of the current cell in
column B. To format the column, select column B by clicking the column header then click the Format
Painter icon and click the column header of column E to apply the formatting you have just copied
from column B. Enter Production in cell E2. The spreadsheet will look like the one shown next.

• To create a plot of production vs. time, click and drag to select cells A3 through B158. Click the Chart
Wizard icon,

or select Chart Wizard from the Tools menu. Scroll to an empty area in the spreadsheet and place the
cursor over the General Spreadsheet area. The cursor will now be in the form of a small cross-hair.
Click inside the spreadsheet and drag the cursor to form a box that represents the area in which the chart
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will be placed. When you are satisfied with the selected area, release the mouse. The Chart Wizard will
appear, as shown next.

• Select 2D as the chart type and select the XY (Scat) chart. Click Next. On the Style page of the Chart
Wizard, select chart style 1.

• Click Next. On the Layout page, you can type the desired layout settings. Click Next. On the Axes
page, you can type the desired axes titles. For this chart, type “Days” for the X-axis and “Total
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Production” for the Y-axis. Click Finish and the chart will appear in the General Spreadsheet in the area
you designated. The chart will look similar to the one shown next.

• To create a plot of weekly production vs. time, select cells D3 through E158. Repeat the steps just given
to create a plot with X-axis labeled “Weeks” and Y-axis labeled “Weekly Production.” The chart will
look similar to the one shown next.

• If you are using a fully functional copy of the software, save the project as Example8.rbp.

• Close the project.





5  Practice Questions

The following practice questions can be performed using BlockSim1. The answers to these practice
questions can be found in Chapter 6 of this training guide.

5.1  Practice Question 1
Consider the following circuit bridge system:

All components are identical, following an exponential life distribution with  = 8.126E-4 failures/
day.

1. Create a Template with the blocks you need to create the RBD and customize the Template
blocks to your liking.

2. Create the reliability block diagram for this system.
3. Estimate the reliability at 200 days using the Analytical QCP. 

1. If you have a demonstration version of BlockSim, you will not be able to enter your own data or perform anal-
yses for these examples. However, example files are available for the examples in Chapter 4.

A

B

C

E

D

λ



Practice Questions BlockSim 7

94     http://BlockSim.ReliaSoft.com

4. Create the Reliability vs. Time plot.
5. Rename the Diagram Sheet to “Bridge System.”
6. Save your project as Quest1.rbp and leave it open.

5.2  Practice Question 2
The reliability predictions of Practice Question 1 can also be performed using simulation. However, the
results are dependent on the number of simulations. This example will take you through such a scenario. 

1. Quest1.rbp will already be open.
2. Open the Maintainability/Availability Simulation window by clicking its icon.

3. On the General page, enter an End Time of 200 and an Increments value of 100. Select Fixed number
of Simulations and type 100 for the Number of Simulations. Click Simulate to perform the simulation.

4. What is the reliability of the system at 200 days? How does this value compare with the reliability
obtained in Practice Question 1?

5. Repeat step 4 with 1,000, 5,000 and 10,000 simulations. When is the reliability estimate closer to the
analytical value obtained in Practice Question 1?

6. Save and close the project.

5.3  Practice Question 3
Consider the following disk array subsystem:
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The failure distributions and parameters for each component are:

The Power Supply subsystem is in a 2-out-of-4 configuration. The Fans are in a 2-out-of-3 configuration.
The Hard Drives are also in a 2-out-of-3 configuration.

Do the following:

1. Create a block for each type of component within a Template and customize the Template blocks to
your liking.

2. Create the RBD and rename the Diagram Sheet to “Disk Array.” 
3. Obtain the Reliability vs. Time plot. 
4. From the plot, determine:

i. The reliability of these units for a mission of 182 days, R(182days).
ii. The mission duration for the system if a 90% reliability is required.
(Hint: Use the Position Indicator in the bottom right corner of RS Draw.)

5. Using the Analytical Quick Calculation Pad, determine:
i. The reliability of the system for a mission of 182 days, R(182days).
ii. The reliability for each subsystem/component.
iii. The mission duration for the system if a 90% reliability is required.
iv. Knowing that the system has successfully operated for 182 days, what is the probability that it will

operate successfully for another 182 days?
v. What is the MTTF for the system?

6. Obtain the pdf plot for the system.
7. Obtain the Failure Rate vs. Time plot for these units. From the plot, what is the failure rate of the system

at 182 days?
8. Add a Spreadsheet into the project. Using the Function Wizard, obtain:

i. The failure rate at 182 days. 
ii. A table of times given reliability, starting from 0.9 to 0.99 with a 0.01 increment.

9. Save the project as Quest3.rbp.
10. Close the project.

Component Distribution Parameters

Array Controllers Weibull
 = 1.2

 = 1,953 days

Power Supply Lognormal
 = 7.0102 (log-mean)

 = 1.2124 (log-std)
Fan Exponential  = 0.000070265 failures/day

Hard Drive Weibull
 = 2.5

 = 3,000 days
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5.4  Practice Question 4
This example shows how you can import previously created diagrams and use them as components in a new
diagram. Consider the following system in which the Disk Array of Practice Question 3 is connected with
the Bridge System of Practice Question 1, as shown next:

1. Create a new project.
2. Import the previously created diagrams, Bridge System and Disk Array, from the Quest1.rbp and

Quest3.rbp projects, respectively.
3. Create the RBD for the system shown above where the blocks represent the corresponding Disk Array

and Bridge System diagrams that were imported.
4. Estimate the reliability of the system at 200 days.
5. Save the project as Quest4.rbp and close it.

5.5  Practice Question 5
A four-engine airplane has two engines on each wing. It requires at least one engine to be operating on each
wing for a successful mission. Assume that the reliability of each engine is 90% for a specified mission
duration.

1. Create a new project.
2. Create the RBD.
3. Obtain the reliability of the system.
4. Add a new diagram and repeat the example, but this time consider a 2-out-of-4 engine configuration. 
5. When is the reliability of the system higher? Why?
6. What would the reliability of each engine be in the first design in order to achieve the system reliability

of the second design? Since the units are identical, you can assume the same feasibility of increasing the
reliability and maximum achievable reliability for each engine.

7. Save the project as Quest5.rbp and close it.
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5.6  Practice Question 6
A subsystem of a machine is composed of a Ball-Bearing subsystem and a Shaft, as shown below:

The inspection times (in hours) for the Ball-Bearing subsystem are given in the table below.

The life data set for the Shaft is given in the table below.

1. Using the 2-parameter Weibull distribution with RRX for the Ball-Bearing data and the lognormal
distribution with RRX for the Shaft data, estimate the reliability of the system at 1,000 hrs.

2. What is the reliability of each component at 1,000 hrs?
3. Save the project as Quest6.rbp and close it.

Number in State Last Inspected State State End Time
5 0 F 600
16 600 F 1,900
12 1,900 F 2,900
18 2,900 F 3,500
18 3,500 F 3,900
2 3,900 F 4,500
6 4,500 F 5,200
17 5,200 F 6,300
73 6,300 S 6,300

Number in State State State End Time
1 F 1,226
1 F 1,943
1 F 2,362
1 F 2,518
1 F 5,462
1 F 6,404
1 F 10,388
5 S 11,772





6  Answers to Practice Questions

The purpose of this section is to provide answers to the Practice Questions in Chapter 5 of this
training guide.

6.1  Practice Question 1
2. 

3. R(200days) = 0.9506
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6.2  Practice Question 2

4. R(200days) = 0.98. Not very accurate.1

5. The reliability estimated using 10,000 simulations is closer to the analytical value.

6.3  Practice Question 3
2. 

4. From the Reliability vs. Time plot:

i. R(182days)  0.99

ii. T  517 days

5. Using the Analytical QCP:
i. R(182days) = 0.9951
ii. Array Controller: 0.9437

Power Supply: 0.9319
Fan: 0.9873
Hard Drive: 0.9991

iii. T = 527.6891
iv. R(182,182) = 0.9676
v. MTTF = 1,316.1014 days

7.  failures/day

8. Using the Function Wizard:

i.  = 7.7E-005 failures/day 

1. Please note that these results may vary since they are based on simulation.
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ii. 

6.4  Practice Question 4
3. 

4. R(200days) = 0.9423

Reliability Time
0.9 527.68907

0.91 505.9283
0.92 483.10633
0.93 458.96273
0.94 433.12952
0.95 405.05836
0.96 373.87145
0.97 338.00912
0.98 294.19751
0.99 232.94363
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6.5  Practice Question 5
2.

Or

3. R = 0.9801
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4. 

5. For the 2-out-of-4 engine configuration: R = 0.9963. The reliability is higher because there is more
redundancy in the 2-out-of-4 configuration.

6. The reliability for each engine is: R = 0.957

6.6  Practice Question 6
1. R(1,000hrs) = 0.8691
2. Bearings: 0.9187

Shaft: 0.946




